ÍNDICE

1. STYLE SHEET: BULLETIN OF THE COMEDIANTES (COMEDIANTES.ORG)
2. BLIND PEER REVIEW BY TWO EXPERTS IN THE FIELD
3. FORMATTING ESSENTIALS
4. SEVEN NOTABLE CHANGES IN THE MLA HANDBOOK, EIGHTH EDITION, 2016
5. ENDNOTES FOR ADDED MATERIALS OR ESSENTIAL CLARIFICATIONS
6. DOCUMENTATION OF SOURCES WITH IN-TEXT PARENTHELITICAL CITATIONS AND A LIST OF WORKS CITED
7. PROPER FORMAT FOR NUMBERS
8. PUNCTUATION PRINCIPLES
9. GUIDELINES FOR IN-TEXT CITATIONS
10. CITATIONS IN LANGUAGES OTHER THAN ENGLISH OR SPANISH
11. SAMPLE ENTRIES IN LIST OF WORKS CITED
Thank you for your interest in submitting new, original scholarship to the Bulletin of the Comediantes. We accept submissions through the Scholastica online peer review system. We welcome article submissions in English and Spanish with a length of 6000 to 12,000 words (including notes and bibliography). Authors should upload a copy of the essay plus an abstract of 150 words in English. Essays should adhere to the format outlined in the MLA Handbook, Eighth Edition, making the necessary adaptations for the study of early-modern Spanish theater.

To make the editorial review as efficient as possible, we urge you to carefully format and proofread your article. The Bulletin of the Comediantes follows the MLA Handbook: Eighth Edition (2016).

For articles in Spanish, we follow the rules of orthography and grammar prescribed by the Real Academia Española’s Ortografía de la lengua española (2010).

To help you navigate formatting standards, we highlight those features of the citation style of particular interest for theater studies. Please send suggestions for how we can refine this style sheet to us (editor@comediantes.org).

BLIND PEER REVIEW BY TWO EXPERTS IN THE FIELD

To honor the ethos of blind peer review, omit information that reveals your identity within your article. Thus, avoid first-person references to your previously published work (e.g., “In a previously published essay, I argued . . . ”). Articles that show potential for publication will be sent to two outside evaluators without any indication of the author’s identity. To preserve the integrity of this process, we recommend you remove the author information—known as metadata—embedded by default within your word processing file. In Word, all references to the author can be found and eliminated by these commands: File / Options / Trust Center / Privacy Options / Document Inspector. (These steps are likely to change in new versions of the software, but a Google search of “remove author name from Word file” along with the name and version of your software program will yield instructions).

FORMATTING ESSENTIALS

Send your essay in MS Word or a compatible format. On the first page of the article itself, list only its title, centered and in bold letters, as with this sample title:

Comedy and Confession in El pobre más rico

Font: Times New Roman, 12-point, including the endnotes and parenthetical citations.

Double spacing between lines throughout the document, including the list of Works Cited. Do not add extra spaces between paragraphs or after block quotes.

One space only after periods and colons. To remove double periods, perform a simple find and replace operation by selecting Advanced Find on the Find dropdown menu at the far right of the Word Home Toolbar. In the Find field type the space key twice, and in the Replace field, type the space key once. Then click the Replace All button.

Works Cited: place the list of Works Cited at the end of your article, with the title in bold without centering.

Images, maps, diagrams, or other supporting materials. For the purpose of the manuscript evaluation, send these and other supplementary materials in a separate PDF file, where each image is numbered in sequence and accompanied by a caption (Figure 1, Figure 2, etc.). The corresponding cross reference within the text of the article would typically be in parenthesis (e.g., see Fig. 1). For essays accepted for publication, the author is responsible for providing a high-resolution image suitable for reproduction in black and white, securing the duplication rights, and paying the corresponding fees.

SEVEN NOTABLE CHANGES IN THE MLA HANDBOOK, EIGHTH EDITION, 2016

1. Editor, edited by, translator, and review of are now spelled out in the list of Works Cited. In contrast, University and Press are still abbreviated when they refer to the publisher, as in U of Toronto P for University of Toronto Press. Likewise, edition and revised edition are abbreviated when referring to versions of a book, as in Expanded ed. for Expanded edition or 7th ed. for 7th edition.

2. Refer to page numbers in the list of Works Cited as p. or pp. Parenthetical citations continue to feature the numbers without the p.

Sample in-text reference:
Mujica’s “Introduction” to her anthology of 2015 offers a guide to versification in the comedia (19–22).

Corresponding entry in the list of Works Cited:

3. City of publication is omitted in the list of Works Cited, unless it is needed to avoid confusion or draw attention to a special feature of the work in question.

4. Journal articles in the list of Works Cited: include vol. and no. (or núm. for articles written in Spanish), year, plus the full date as given for the issue consulted. (Note that when written in English, seasons will be lowercase in the body of your writing, but will be capitalized when indicating a publication date within an entry in the list of Works Cited.)

Sample works-cited entry for a journal you consulted in print:

Sample works-cited entry for a journal you consulted through an online portal:

[The MLA Handbook recommends citing the doi (digital object identifier) if available. If it is not, cite the URL without the http://. In either case, the location information appears in the works-cited entry without brackets.]

5. Citing Web pages and projects
Determine the most meaningful date for the listing. This might be the date range of a web project’s development, the
specific posting date, or the date of consultation.
Sample works-cited entry for a web-based project
[2012−16 is the date range for the project’s development]
Sample works-cited entry: blog post or comment

6. More than one publisher. Use a forward slash (/) to separate the companies, as with “Iberoamericana / Vervuert.”
7. The container is a new concept that refers to journals, edited volumes, multi-volume collections, and online portals of various kinds (JSTOR, Project Muse, HathiTrust Digital Library, etc.). The essential format for citing a container is period before its title, title in italics, and comma following the title. Examples below show the container concept applied for three common kinds of sources for the Comediantes:
[Above, the journal, Confluencia, and the portal, JSTOR, are both containers, and thus italicized and followed by a comma.]
[The container is the volume titled Comedias de Lope de Vega Carpio. Parte XIV.]
[Here, the edited volume is the container.]

ENDNOTES FOR ADDED MATERIALS OR ESSENTIAL CLARIFICATIONS
Do not present complete bibliographical citations, extensive analysis, or lengthy citations in the notes. Include the full citation information only in the list of Works Cited. The corresponding endnote will include the same information as the parenthetical in-text citations (author and page; or author, title, and page in cases of multiple entries by one author).

DOCUMENTATION OF SOURCES WITH IN-TEXT PARENTHETICAL CITATIONS AND A LIST OF WORKS CITED
List sources in a Works Cited section, rather than a bibliography. Within the body of the article, when you refer to a text listed among the Works Cited, include the author’s name and the page number in parentheses, with no comma. For example: (Asensio 146). If there are two or more works by the same author, include a short version of the title. For example:
(Asensio, Estudios portugueses 146).
When the list of Works Cited includes more than one work by an author, use three hyphens (---) for the additional entries. List the entries in alphabetical order, as opposed to chronological order:

PROPER FORMAT FOR NUMBERS
Page and line numbers: zero to ninety-nine, list the second number in full:
5−7
12−19
55−59
For numbers of three or more digits, list the last two digits of the second number, unless needed for clarity. Note that commas are not used in page, line, or verse numbers:
107−09
586−601
1217−19
2796−3001
Arabic numerals for chapters, volume numbers, and parts of books:
acto 1
escena 1
capítulo 52
Roman numerals in limited cases:
As suffixes of names:
Philip III
Pio V
Citations of the pages of a book thus numbered, with some prefaces and introductions. Here, use lowercase Roman numerals spelled out in full (e.g., Ynduráin xviii-xix).
Centuries when mentioned in articles written in Spanish (e.g., siglo XVI). But in English, the corresponding mention would be “sixteenth century.”

Range of years:
If the first two digits of the years are the same, omit them in the second date: 1598−99
Otherwise, write both years in full:
1598−99
Do not abbreviate dates prior to AD 1:
264−241 BC
Dates: written out in articles, abbreviated in list of Works Cited
In the body of an article, do not abbreviate dates. Maintain a consistent style, whether 15 August 1617 or August 15, 1617. In the latter, the year would be set apart by a comma if there is no other punctuation: “August 15, 1617, is the date documented for its performance in the Alcázar of Madrid.”
Punctuation placement after citations:

When writing in English, place periods and commas before the closing quotation marks:

“We are at a crossroads.”
“We are,” she stated, “at a fork in the road.”

When writing in Spanish, you may opt to follow the most common usage, placing the period or comma after the quotation mark. Please maintain consistency.

“Estamos en una encrucijada”.
“Nos encontramos”, insistió, “en un punto decisivo”.

Possessive forms of singular proper nouns: use an apostrophe plus an “s”:

Cervantes’s
Velázquez’s
Marx’s

Ellipsis
Omission within a sentence: indicate with three periods, with a space before each and a space after the last. The MLA Handbook no longer calls for brackets around an ellipsis.

For example:

“Cosimo Lotti . . . mounted productions in the many
dramatic spaces found in the palace” (Mujica 15–16).

With the omission of a line or more of a quotation in verse, use a line of spaced periods equal in length to the line of poetry:

For example:

CAMILO. Bien puedo estar dese daño
por muchas causas seguro;
........................................
Pues juna Iris que tiene,
y un Mercurio embajador! (Vega, La viuda valenciana,
2.1903–04, 1917–18)

In cases of an ellipsis at the end of a sentence, insert a period after the last word of the quotation, then add the ellipsis with three more periods, each preceded with a space:

For example:

Continuing her concluding remarks, Quintero notes that “Comedia women may never have been able to escape the tyranny of roles . . .”

If a parenthetical reference follows, the sentence period will appear after the final parenthesis.

En otro momento, la autora propone que “women may never have been able to escape the tyranny of roles . . .” (Quintero 221).

Serial Comma (before and and or in English and y and o in Spanish)

In English, place a comma before and: “Tirso, Mira de Amescua, and Ana Caro.”

In Spanish, do not place a comma before y: “Tirso, Mira de Amescua y Ana Caro.”

Other Comma Cruxes

Please review Cook’s Line by Line “Commas—Good, Bad, and Indifferent” (109-31). For articles in Spanish, see the RAEE’s Ortografía de la lengua española (3.4.2). See also the guide to orthography by Leonardo Gómez Torrego (2011).

Parenthetical Elements (dashes and parentheses)

Dashes mark a sharper break in the continuity of a sentence than do commas. Parentheses, in turn, mark a still sharper one. Please remember: used sparingly, these pauses add impact. But heavy use invites suspicion that they are a “lazy author’s when-in-doubt expedient . . .” (Cook 136).

Em-dashes: Use with no spaces before or after. If Microsoft Word’s AutoFormat is activated and the correct box is checked (under File> Options> Proofing> AutoCorrect Options> AutoFormat), the software automatically turns two hyphens (-) inserted with no spaces before or after into an em-dash. Alternatively, the em-dash can be inserted as a special character through way of the Symbols tab accessed through the Insert menu option.

For example: “The attribution of this auto—as is the case with many dramatic texts of the period—has remained elusive to scholars.”

GUIDELINES FOR IN-TEXT CITATIONS

In keeping with the practices recommended by leading research teams in theater studies, citations of literary texts and other primary sources should modernize orthography and punctuation, except where so doing would alter the rhyme scheme or otherwise mask another point you highlight. If you have compelling reasons to retain the period orthography, explain briefly in an endnote.

Verse citations within the text:

When you quote two or three lines of verse within your prose text, use a forward slash (/) with a space before and after to indicate where line breaks appear in the original.

Camilo expresa su desengaño al decir “Bien puedo estar
dese daño / por muchas causas seguro” (La viuda valenciana
2.1903–04).

Dialogue within a play:

Set off the dialogue within a play text by indenting half an inch from the left margin. The character’s name appears in all capital letters followed with a period. Indent all the lines that follow an additional amount. If the quoted dialogue shifts to another character, begin that line by again indenting half an inch.

CAMILO. No tiene el mundo valor
cuando de su cielo viene.
LEONARDA. Vos sois estraño galán;
nunca tal oí decir. (La viuda valenciana 2.1919–22)

The MLA Handbook (3.3.2) recommends citing poems and verse plays with the act number followed by the line or verse number, as above. If you cite only verse numbers—as would be reasonable using a contemporary edition that follows the standard practice of numbering the three acts of a comedia
When citing from an older (“classic”) edition without numbered lines (e.g., plays found in the Biblioteca de Autores Españoles), cite with the page number as well as another explicit division, such as the act number. For example, an in-text reference to the classic Menéndez Pelayo edition of Lope de Vega’s La Santa Liga would read as follows: “No porque el Tigris pasé / y a Mesopotamia vi . . . (La Santa Liga act I, 232).” Here, a first citation could include an endnote to clarify that the parenthetical numbering after the act number refers to pages, as opposed to verse number. Please be consistent.

Multivolume editions of authors

To cite one volume of a multivolume work, you need only list the volume number in the works-cited entry, not in the parenthetical citation.

*For example: in-text citation, plus corresponding works-cited entry*

Others have proposed we consider the event a watershed in allowing for more nuanced examinations of the Ottoman adversary (Mas 192).


When your article refers to more than one volume, the in-text citation would include the volume number, followed by a colon and a space. Do not include the words volume, t., or pp. or the corresponding abbreviation (vol., t., or pp.).

Other critics aver that only the first two acts offer a satisfying dramatic structure (e.g., Mas 1: 393—95).


Should you discuss the contents of an entire volume, you would cite it by placing a comma after the author’s name and use the abbreviation vol.

We have at least one programmatic survey of representations of the Ottoman empire within the comedia (Mas, vol. 2).

If you incorporate this reference into the sentence, volume is spelled out: “In volume 1, Albert Mas pays extensive attention to these developments.”

**CITATIONS IN LANGUAGES OTHER THAN ENGLISH OR SPANISH**

Following the MLA *Handbook* 1.3.8, we recommend that you include a translation of quotations in languages other than English or Spanish if you believe a significant portion of the readership will not understand it. For Latin and the most commonly used Romance Languages within comedía studies—namely Portuguese, French, and Italian—will require your assessment of accessibility. When you do include a translation, please observe the following principles:

In general, the translation appears right after the quotation, though there may be cases where the reverse is appropriate. If the quotation and translation appear within the text, set off the translation by placing the translation in double quotation marks and parentheses or without parentheses, in single quotation marks.

The playwright also echoes Virgil’s image of tilling the soil from *Georgics* 1.46, where the poetic voice conjures how, amid his spring toil, “et sulco attritus splendescere vomer” (“the plow blade shines as the furrow rubs against it”; Ferry 4–5).

Alternatively, you might dispense with the parenthesis:

The playwright also evokes Virgil’s image of spring toil from *Georgics* 1.46, where the “speldescere vomer”’ ‘the plow blade shines’ (Ferry 5).

Here, an initial endnote might be needed to clarify that the translation comes from poet David Ferry. If you provide your own translation, insert my trans. in the parenthetical citation. If your article includes many of your own translations, include an endnote after the first one.

For quotations set off from the text, do not use quotation marks.

Vere novo, gelidus canum cum montibus umor
liquitur et Zephyro putris se glaeba resolvit,
depresso incipiat iam tum mihi taurus aratro
ingemere, et sulco attritus splendescere vomer. (*Georgics* 1.43–46)

When spring begins and the ice-locked streams begin
To flow down from the snowy hills above
And the clods begin to crumble in the breeze,
The time has come for my groaning ox to drag
My heavy plow across the fields, so that
The plow blade shines as the furrow rubs against it. (Ferry 5)

Quotations from non-Latinate languages (Arabic, Hebrew, Greek, etc.) should be presented with consistency, whether in the original writing system or in the romanized script. Note that people, places, and organizations are romanized by convention.

**SAMPLE ENTRIES IN LIST OF WORKS CITED**

**Book with one author**


**Two authors or editors**


**Journal article consulted in a print edition**


**Journal article consulted through an online portal**


**Literary edition**

Multivolume collection of an author’s works

Chapter from an edited volume

Versions (see MLA Handbook, 2.3)
Reissued books:

Numbered versions:

Web site

Blog posting